Creating Calendar and Contact Integrations in
Cisco Unity Connection

See the following sections:

About Calendar Integrations in Cisco Unity Connection, page 36-1
About Contact Integrations in Cisco Unity Connection, page 36-2

Creating a Calendar and Contact Integration with Exchange 2007 in Cisco Unity Connection,
page 36-2

Creating a Calendar and Contact Integration with Exchange 2003 in Cisco Unity Connection,
page 36-9

Creating a Calendar and Contact Integration with Cisco Unified MeetingPlace in Cisco Unity
Connection, page 36-16

Creating a Calendar Integration with Cisco Unified MeetingPlace Express in Cisco Unity
Connection, page 36-21

For information on configuring calendar and contact integrations in Cisco Unity Connection, see the
“Configuring Cisco Unity Connection 10.x and Microsoft Exchange for Unified Messaging” chapter
and/or the “Configuring Cisco Unity Connection 10.x and Cisco Unified MeetingPlace for Unified
Messaging” chapter of the Unified Messaging Guide for Cisco Unity Connection Release, available at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/10x/unified_messaging/guide/10xcucu
mgx.html.

About Calendar Integrations in Cisco Unity Connection

When integrated with supported calendar applications (Exchange 2007, Exchange 2003, Cisco Unified
MeetingPlace, or Cisco Unified MeetingPlace Express), Cisco Unity Connection enables users to do the
following by phone:

Hear a list of upcoming meetings (Outlook meetings only).

Join a meeting that is in progress (MeetingPlace and MeetingPlace Express meetings only).
Hear a list of the participants for a meeting.

Send a message to the meeting organizer.

Send a message to the meeting participants.

Accept or decline meeting invitations (Outlook meetings only).

Set up immediate meetings (MeetingPlace and MeetingPlace Express meetings only).
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Cancel a meeting (meeting organizers only).

About Contact Integrations in Cisco Unity Connection

When integrated with Exchange 2007 or Exchange 2003, Cisco Unity Connection enables users to
import Exchange contacts by using the Unity Connection Messaging Assistant web tool. The contact
information can then be used in rules that users create in the Cisco Unity Connection Personal Call
Transfer Rules web tool and when users place outgoing calls by using voice commands.

Creating a Calendar and Contact Integration with Exchange 2007
in Cisco Unity Connection

If you have Exchange 2007 installed, you can integrate Cisco Unity Connection with Exchange 2007 so
that users can do the following:

Review upcoming meetings by phone.

Import Exchange contacts. The contact information can be used in rules that users create in the
Personal Call Transfer Rules web tool and when users place outgoing calls by using voice
commands.

For information on configuring calendar and contact integrations in Cisco Unity Connection, see the
“Configuring Cisco Unity Connection 10.x and Microsoft Exchange for Unified Messaging ” chapter
and/or the “Configuring Cisco Unity Connection 10.x and Cisco Unified MeetingPlace for Unified
Messaging” chapter of the Unified Messaging Guide for Cisco Unity Connection Release, available at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/10x/unified_messaging/guide/10xcucu
mgx.html.

Task List for Creating a Calendar and Contact Integration with Exchange 2007
in Cisco Unity Connection

1.

Review the system requirements to confirm that all requirements for Exchange 2007 and the
Cisco Unity Connection server have been met. See the “Requirements for the Exchange 2007
Calendar and Contact Integration in Cisco Unity Connection” section on page 36-3.

Configure Exchange 2007. See the “Configuring Exchange 2007 for the Calendar and Contact
Integration in Cisco Unity Connection” section on page 36-3.

Configure Unity Connection. See the “Configuring Cisco Unity Connection for the Exchange 2007
Calendar and Contact Integration” section on page 36-6.

(When enabling personal call transfer rules only) Verify that the users or templates are assigned to
a class of service that enables them to use the personal call transfer rules feature.

Configure the Unity Connection users. See the “Configuring Users for the Exchange 2007 Calendar
and Contact Integration in Cisco Unity Connection” section on page 36-7.

Test the calendar integration. See the “Testing the Exchange 2007 Calendar Integration in
Cisco Unity Connection” section on page 36-8.

To teach users how to use the Unity Connection calendar, refer them to the following:
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For listing, joining, and scheduling meetings, see the “Cisco Unity Connection Phone Menus and
Voice Commands” chapter of the User Guide for the Cisco Unity Connection Phone Interface
(Release 10.x) at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/10x/user/guide/phone/b_10xcucugp
hone.html.

For importing Exchange contacts, see the “Managing Your Personal Contacts” chapter of the User
Guide for the Cisco Unity Connection Messaging Assistant Web Tool (Release 10.x) at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/10x/user/guide/assistant/b_10xcucu
gasst.html.

For using personal call transfer rules, see the User Guide for the Cisco Unity Connection Personal
Call Transfer Rules Web Tool (Release 10.x) at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/10x/user/guide/pctr/b_10xcucugpct
r.html.

Requirements for the Exchange 2007 Calendar and Contact Integration in
Cisco Unity Connection

The calendar and contact integration with Exchange 2007 has the following requirements:

Exchange 2007 as described in the “Requirements for Accessing Calendar Information for
Meetings” and “Requirements for Accessing Exchange Contact Information” sections of System
Requirements for Cisco Unity Connection Release 10.x at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/10x/requirements/10xcucsysreqs.ht
ml.

Cisco Unity Connection installed as described in the Installation Guide for Cisco Unity Connection
Release 10.x at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/10x/installation/guide/10xcucigx.ht
ml.

Configuring Exchange 2007 for the Calendar and Contact Integration in
Cisco Unity Connection

Step 1
Step 2
Step 3
Step 4

Do the following tasks to configure Exchange 2007 for the calendar and contact integration:

1.
2.

Confirm that the Exchange 2007 server has been configured to include the “Client Access” role.

Do the “To Configure Access to Exchange 2007 for the Calendar and Contact Integration in
Cisco Unity Connection” procedure on page 36-3.

(Optional) If you are using SSL for secure access to the Exchange 2007 server, do the “To Configure
Secure Access to Exchange 2007 for the Calendar and Contact Integration (With SSL) in
Cisco Unity Connection” procedure on page 36-4.

To Configure Access to Exchange 2007 for the Calendar and Contact Integration in Cisco Unity Connection

On the Exchange server, open the Internet Services (IIS) Manager application.

Go to Internet Information Services > <server name> > Web Sites > Default Web Site.

Right-click Exchange and select Properties.

In the Exchange Properties dialog box, select the Virtual Directory tab.

System Administration Guide for Cisco Unity Connection Release 10.x g


http://www.cisco.com/en/US/docs/voice_ip_comm/connection/10x/user/guide/phone/b_10xcucugphone.html
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/10x/user/guide/phone/b_10xcucugphone.html
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/10x/user/guide/assistant/b_10xcucugasst.html
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/10x/user/guide/assistant/b_10xcucugasst.html
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/10x/user/guide/pctr/b_10xcucugpctr.html
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/10x/user/guide/pctr/b_10xcucugpctr.html
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/10x/requirements/10xcucsysreqs.html
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/10x/requirements/10xcucsysreqs.html
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/10x/installation/guide/10xcucigx.html
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/10x/installation/guide/10xcucigx.html

Chapter 36 Creating Calendar and Contact Integrations in Cisco Unity Connection |

W Creating a Calendar and Contact Integration with Exchange 2007 in Cisco Unity Connection

Step 5
Step 6
Step 7
Step 8
Step 9
Step 10

Step 11
Step 12
Step 13
Step 14

Step 15
Step 16
Step 17

Step 18
Step 19
Step 20

Step 21

Step 1

Under Content For This Resource Should Come From, select A Directory Located On This Computer.
Confirm the Local Path is set to \.\BackOfficeStorage\<your-domain.com>\MBX.

Select the Read check box.

Select the Directory Security tab.

Under Authentication and Access Control, select Edit.

In the Authenticated Access section of the Authentication Methods dialog box, check the check boxes
for one or more of the following options:

e Integrated Windows authentication (sometimes referred to as NTLM)
e Basic Authentication
e Digest Authentication for Windows Domain Servers
Select OK.
In the Exchange Properties dialog box, select OK.
Go to Internet Information Services > <server name> > Web Service Extensions.

In the right-hand pane, select WebDav and confirm that the status is “Allowed.” If the status is not
“Allowed”, click Allow.

On the Exchange server, open the Exchange Management Console.

Go to Server Configuration > Mailbox.

Do the following for each mailbox that you want to configure for the calendar and contact integration:
a. In the upper middle pane, select the mailbox name.

b. In the lower middle pane, select the WebDav tab.

c. Right-click Exchange (Default Web Site) and select Properties.

d. In the Exchange (Default Web Site) Properties dialog box, select the Authentication tab.

e. Select Use One or More Standard Authentication Methods and select the same authentication
method(s) that you configured in Step 10.

Click OK.

Open the Exchange Management Shell.

In the Exchange Management Shell, enter the following command:
iisbreset /noforce

Press Enter.

To Configure Secure Access to Exchange 2007 for the Calendar and Contact Integration (With SSL) in Cisco Unity
Connection

~

Note If you have already configured secure IMAP with SSL and have enabled the certificate for both
IMAP and IIS, then you can skip the following procedure and continue with the “Configuring
Cisco Unity Connection for the Exchange 2007 Calendar and Contact Integration” section on
page 36-6.

On the Exchange Server, open the Exchange Management Shell application.
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Step 2

Step 3

Step 4

Step 5

Step 6
Step 7

Step 8
Step 9

Step 10
Step 11
Step 12

Step 13
Step 14

Step 15
Step 16

Creating a Calendar and Contact Integration with Exchange 2007 in Cisco Unity Connection 1l

Enter the following command, where <Exchange server> is the IP address or fully qualified domain
name of the Exchange server and <friendly name> is the friendly name that you chose for the Exchange
server:

¢ new-exchangecertificate -generaterequest -domainname <Exchange server> -friendlyname
<friendly name>-path c:\csr.txt

A

Caution  The domain name for the Exchange server must be the IP address or the fully qualified domain
name (recommended) so that the Unity Connection server can successfully ping the Exchange
server. Otherwise, the calendar and contact integration may not function correctly.

Press Enter.
A Certificate Signing Request (CSR) file with the name Csr.txt is created in the root directory.
Send the CSR file to a Certification Authority (CA), which generates and sends back a new certificate.

~

Note  You must have a copy of the CA public root certificate or public root certificate chain. This
certificate is needed for configuring Unity Connection to trust the Exchange 2007 server.

Save the new certificate in a location that is accessible to the Exchange server on which you want to
import the certificate.

On the Exchange Server, open the Exchange Management Shell application.

Enter the following command, where <path> is the full path of the new certificate that you received from
the CA:

import-exchangecertificate -path <path>
Press Enter.
Enter the following command:
dir cert:\localmachine\my | fl
Press Enter.
Highlight the “thumbprint” property and press Ctrl-C to copy it to the clipboard.

If Unity Connection will be configured to use IMAP to access both email and calendar data from
Exchange 2007, enter the following command, where <thumbprint> is the “thumbprint” that you copied
in Step 11:

enable-exchangecertificate -thumbprint <thumbprint> -services "IIS,IMAP"

If Unity Connection will not be configured to use IMAP but will be configured to use calendar data from
Exchange 2007, enter the following command, where <thumbprint> is the “thumbprint” that you copied
in Step 11:

enable-exchangecertificate -thumbprint <thumbprint> -services "IIS"
Press Enter.

If you want data transmitted as clear text, skip the remaining steps in this procedure and continue with
the “Configuring Cisco Unity Connection for the Exchange 2007 Calendar and Contact Integration”
section on page 36-6. Otherwise, open the IIS Manager application.

Go to IIS > <server name> > Web Sites > Default Web Site.

Right-click Default Web Site and select Properties.
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Step 17
Step 18
Step 19
Step 20
Step 21

In the Properties dialog box, select the Directory Security tab.
Under Secure Communications, select Edit.

Check the Require Secure Channel check box.

Select OK.

In the Properties dialog box, select OK.

Configuring Cisco Unity Connection for the Exchange 2007 Calendar and
Contact Integration

Step 1
Step 2
Step 3
Step 4
Step 5
Step 6
Step 7

Step 8

Step 9

Step 10
Step 11

Do the following procedure.

To Configure Cisco Unity Connection for the Exchange 2007 Calendar and Contact Integration

In Cisco Unity Connection Administration, expand System Settings, then select External Services.
On the Search External Services page, select Add New.

On the New External Service page, in the Type list, select Exchange 2007 External Service Template.
Check the Enabled check box to enable the calendar and contact integration.

In the Display Name field, enter a descriptive name.

In the Server field, enter the IP address or host name for the Exchange 2007 server.

In the Authentication Mode field, select the applicable setting to match the authentication mode that is
used by the Exchange server.

In the Security Transport field, select the applicable setting:
e None—Unity Connection does not use a secure Unity Connection with the Exchange 2007 server.
¢ SSL—Unity Connection uses an SSL Unity Connection with the Exchange 2007 server.

If you selected “SSL” and you want Unity Connection to validate the Exchange 2007 server certificate,
check the Validate Server Certificate check box.

Self-signed certificates cannot be validated. If you selected SSL and you are using self-signed
certificates, do not check the Validate Server Certificate check box, or Unity Connection will not be
able to access Exchange.

A

Caution The CN value on the server certificate subject line or the subjectAltName:dnsname field of
the server certificate must match the setting of Server field. Otherwise, validation of the server
certificate will fail.

The root certificate or all certificates in a root certificate chain of the Certification Authority
(CA) that signed the server certificate must be installed as Unity Connection-trust certificates
in Cisco Unified Operating System Administration. Otherwise, validation of the server
certificate will fail.

Under Service Capabilities, check the User Access to Calendar and Personal Contacts check box.

Select Verify. A message appears indicating whether the Cisco Unity Connection configuration has been
successfully verified.

System Administration Guide for Cisco Unity Connection Release 10.x
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If the verification fails, confirm the configuration for Exchange 2007 and Cisco Unity Connection.

Select Save.

Configuring Users for the Exchange 2007 Calendar and Contact Integration in
Cisco Unity Connection

A

Do the following procedure.

Caution

Step 1
Step 2

Step 3
Step 4
Step 5

Step 6
Step 7

Step 8

Step 9

Exchange 2007 must have a mailbox and Active Directory must have a user account for each Unity
Connection user that you are configuring.

To Configure Users for the Exchange 2007 Calendar and Contact Integration in Cisco Unity Connection

In Cisco Unity Connection Administration, expand Users, then select Users.
On the Search Users page, select the alias of a user.

~

Note If the user alias does not appear in the search results table, set the applicable parameters in the
search fields at the top of the page, and select Search.

On the Edit User Basics page, on the Edit menu, select External Service Accounts.
On the External Service Accounts page, select Add New.

On the New External Service Accounts page, in the External Service field, select the display name
that you entered in the “To Configure Cisco Unity Connection for the Exchange 2007 Calendar and
Contact Integration” procedure on page 36-6.

In the Email Address field, enter the Exchange email address in Active Directory for the user.
In the Sign-In Type field, select the applicable option:

e Use Unity Connection Alias—This option is useful when the Active Directory domain alias for the
user is the same as the Unity Connection user alias. Unity Connection signs in the user with the
Unity Connection user alias.

e Use User ID Provided Below—(Recommended) Enter the Active Directory domain alias for the
user (useful when the User ID setting is different from the Unity Connection user alias). Unity
Connection signs in the user with the setting in this field.

(Only when the Use User ID Provided Below option is selected in Step 7) In the User ID field, enter the
User ID setting from Active Directory.

If known, in the Password field, enter the Active Directory domain password for the user. Unity
Connection signs in the user with the setting in this field.
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Step 10

Step 11
Step 12

Step 13

~

Note If you leave the Password field blank, users must sign in to Cisco Personal Communications
Assistant and enter their password on the External Services Accounts page. For details, see the
“Changing Your Cisco Unity Connection Passwords” chapter of the User Guide for the
Cisco Unity Connection Messaging Assistant Web Tool (Release 10.x) at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/10x/user/guide/assistant/b_10x
cucugasst.html.

Under Service Capabilities, check the User Access to Calendar and Personal Contacts check box.

a~

Note A user can have only one external service that has the User Access to Calendar and Personal
Contacts check box or the User Access to Calendar check box checked.

Select Save.

To check the calendar configuration for the user, select Test. The Task Execution Results window
appears with the test results.

If any part of the test fails, verify the configuration for Exchange 2007, Active Directory, Cisco Unity
Connection, and the Unity Connection user.

Repeat Step 2 through Step 12 for all remaining users.

Testing the Exchange 2007 Calendar Integration in Cisco Unity Connection

Step 1
Step 2
Step 3
Step 4

Step 5
Step 6

Step 7

Do the following procedure.

To Test the Configuration for the Exchange 2007 Calendar Integration in Cisco Unity Connection

Sign in to Outlook.
On the Go menu, select Calendar.
On the File menu, select New > Meeting Request.

Enter values in the required fields to schedule a new meeting for the current time, and invite a user who
has an account on Cisco Unity Connection.

Select Send.

Sign in to the Cisco Unity Connection mailbox of the user that you invited to the Outlook meeting in
Step 4.

If the user account is configured for speech access, say Play Meetings.

If the user account is not configured for speech access, press 6, and then follow the prompts to list
meetings.

Unity Connection reads the information about the Exchange 2007 meeting.
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Creating a Calendar and Contact Integration with Exchange 2003
in Cisco Unity Connection

If you have Exchange 2003 installed, you can integrate Cisco Unity Connection with Exchange 2003 so
that users can do the following:

Review upcoming meetings by phone or while using the Cisco Personal Communications Assistant
(PCA).

Import Active Directory contacts. The contact information can be used in rules that users create in
the Personal Call Transfer Rules web tool and when users place outgoing calls by using voice
commands.

For information on configuring calendar and contact integrations in Cisco Unity Connection, see the
“Configuring Cisco Unity Connection 10.x and Later and Microsoft Exchange for Unified Messaging”
chapter and/or the “Configuring Cisco Unity Connection 10.x and Later and Cisco Unified MeetingPlace
for Unified Messaging” chapter of the Unified Messaging Guide for Cisco Unity Connection Release,
available at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/10x/unified_messaging/guide/10xcucu
mgx.html.

Task List for Creating a Calendar and Contact Integration with Exchange 2003
in Cisco Unity Connection

1.

Review the system requirements to confirm that all requirements for Exchange 2003 and the
Cisco Unity Connection server have been met. See the “Requirements for the Exchange 2003
Calendar and Contact Integration in Cisco Unity Connection” section on page 36-10.

Configure Exchange 2003. See the “Configuring Exchange 2003 for the Calendar and Contact
Integration in Cisco Unity Connection” section on page 36-10.

Configure Unity Connection. See the “Configuring Cisco Unity Connection for the Exchange 2003
Calendar and Contact Integration” section on page 36-13.

(When enabling personal call transfer rules only) Verify that the users or templates are associated
with a class of service that enables them to use the personal call transfer rules feature.

Configure the Unity Connection users. See the “Configuring Users for the Exchange 2003 Calendar
and Contact Integration in Cisco Unity Connection” section on page 36-14.

Test the calendar integration. See the “Testing the Exchange 2003 Calendar Integration in
Cisco Unity Connection Do the following procedure.” section on page 36-15.

To teach users how to use the Unity Connection calendar, refer them to the following:

For listing, joining, and scheduling meetings, see the “Cisco Unity Connection Phone Menus and
Voice Commands” chapter of the User Guide for the Cisco Unity Connection Phone Interface
(Release 10.x) at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/10x/user/guide/phone/b_10xcucugp
hone.html.

For importing Active Directory contacts, see the “Managing Your Personal Contacts” chapter of the
User Guide for the Cisco Unity Connection Messaging Assistant Web Tool (Release 10.x) at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/10x/user/guide/assistant/b_10xcucu
gasst.html.
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e For using personal call transfer rules, see the User Guide for the Cisco Unity Connection Personal
Call Transfer Rules Web Tool (Release 10.x) at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/10x/user/guide/pctr/b_10xcucugpct
r.html.

Requirements for the Exchange 2003 Calendar and Contact Integration in
Cisco Unity Connection

The calendar and contact integration with Exchange 2003 has the following requirements:

e Exchange 2003 as described in the “Requirements for Accessing Calendar Information for
Meetings” and “Requirements for Accessing Exchange Contact Information” sections of System
Requirements for Cisco Unity Connection Release 10.x at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/10x/requirements/10xcucsysreqs.ht
ml.

¢ Cisco Unity Connection installed as described in the Installation Guide for Cisco Unity Connection
Release 10.x at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/10x/installation/guide/10xcucigx.ht
ml.

Configuring Exchange 2003 for the Calendar and Contact Integration in
Cisco Unity Connection

Do the applicable procedures.

To Create the Privileged Service Account for the Exchange 2003 Calendar and Contact Integration in Cisco Unity
Connection

Step 1 On the Domain Controller, open Active Directory Users and Computers.
Step2  Right-click Users and select New > User.
Step3  Create a domain user account with alias cucsve.

~

Note It is not necessary to create a mailbox for this user.

Step4  On the Exchange server, on the Windows Start menu, select Programs > Microsoft Exchange >
System Manager.

Step5  Under Servers, right-click the server name and select Properties.
Step6  In the Properties dialog box, select the Security tab.

Step 7 Select Add and add cucsve (the alias for the domain account that you created in Step 3) to the list of
accounts with permissions on the store.

Step8  Select Check Names.
Step9  Select OK.

Step10 In the list, select cuesve (the alias for the domain account that you created in Step 3).
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Step 12

Step 1
Step 2
Step 3
Step 4
Step 5
Step 6
Step 7
Step 8
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Step 11
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Step 14
Step 15
Step 16
Step 17

Step 18
Step 19

Step 20
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Set the permissions for the domain account alias to allow for Receive As, Send As, and Administer
Information Store. Deny all other permissions.

In the Properties dialog box, select OK.

If you are not using SSL for access to the Exchange 2003 server, do the “To Configure Basic Access to
Exchange 2003 for the Calendar and Contact Integration (Without SSL) in Cisco Unity Connection”
procedure on page 36-11.

If you are using SSL for secure access to the Exchange 2003 server, do the “To Configure Secure Access
to Exchange 2003 for the Calendar and Contact Integration (With SSL) in Cisco Unity Connection”
procedure on page 36-12.

To Configure Basic Access to Exchange 2003 for the Calendar and Contact Integration (Without SSL) in Cisco Unity
Connection

On the Domain Controller, go to Active Directory Users and Computers.
Under Users, select all user accounts that have calendars that you want Unity Connection to access.
Right-click the highlighted users and select Exchange Tasks.
In the Exchange Tasks dialog box, select Configure Exchange Features.
Under Protocols, select Outlook Web Access.
Select the Enable icon.
Select Next.
Select Finish.
On the Exchange server, open the Exchange System Manager application.
Go to Servers > <server name> > Protocols > HTTP > Exchange Virtual Server.
Select the Settings tab.
Confirm that the Enable Forms Based Authentication check box is unchecked.
Select OK.
Go to Servers > <server name> > Protocols > HTTP > Exchange Virtual Server > Exchange.
Right-click Exchange and select Properties.
In the Properties dialog box, select the Access tab.
Confirm that the following check boxes are checked:
e Read
e Write
e Directory Browsing
Select Authentication.
Confirm that one or more of the following options are enabled:
e Basic
e Digest
e Integrated Windows Authentication

Select OK.
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Step 21
Step 22
Step 23
Step 24
Step 25
Step 26
Step 27
Step 28
Step 29

Step 1
Step 2
Step 3
Step 4
Step 5
Step 6
Step 7

Step 8
Step 9

Step 10
Step 11

Step 12
Step 13
Step 14
Step 15

In the Properties dialog box, select OK.

Open the IIS Manager application.

Go to IIS > <server name> > Web Sites > Default Web Site.

Right-click Default Web Site and select Properties.

In the Properties dialog box, select the Directory Security tab.

Under Authentication and Access Control, select Edit.

Confirm that the enabled authentication schemes match those that you enabled in Step 19.
Select OK.

In the Properties dialog box, select OK.

To Configure Secure Access to Exchange 2003 for the Calendar and Contact Integration (With SSL) in Cisco Unity
Connection

On the Exchange server, open the IIS Manager application.

Go to IIS > Web Sites > Default Web Site.

Right-click Default Web Site and select Properties.

In the Properties dialog box, select the Directory Security tab.
Under Secure Communications, select Server Certificate.
Select Next.

Select Create a New Certificate.

a~

Note  If this option is not available, you must remove the existing certificate and do this step again.

Select Prepare the Request Now, But Send It Later.

Follow the prompts in the wizard to enter the applicable information for your organization.

A

Caution The “common name” for the Exchange server certificate must be the IP address or the fully
qualified DNS name (recommended) of the Exchange server. Otherwise, the calendar and
contact integration may not function correctly.

Save the Certificate Signing Request (CSR) as a file.
Send the CSR file to a Certification Authority (CA), which generates and sends back a new certificate.

~

Note  You must have a copy of the CA public root certificate or public root certificate chain. This
certificate is needed for configuring Unity Connection to trust the Exchange 2003 server.

Return to the IIS Manager application.
Go to IIS > Web Sites > Default Web Site.
Right-click Default Web Site and select Properties.

In the Properties dialog box, select the Directory Security tab.
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Step 16
Step 17
Step 18
Step 19
Step 20
Step 21
Step 22
Step 23
Step 24
Step 25
Step 26
Step 27
Step 28
Step 29
Step 30
Step 31
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Under Secure Communications, select Server Certificate.

Select Next.

Select Process the Pending Request and Install the Certificate and select Next.
Browse to the local file system and select the new certificate that CA sent.
Select Next.

Confirm that the certificate information is valid and select Next.

Select Finish.

In the Properties dialog box, select OK.

Return to the IIS Manager application.

Go to IIS > <sever name> > Web Sites > Default Web Site.

Right-click Default Web Site and select Properties.

In the Properties dialog box, select the Directory Security tab.

Under Secure Communications, select Edit.

Check the Require Secure Channel check box.

Select OK.

In the Properties dialog box, select OK.

Configuring Cisco Unity Connection for the Exchange 2003 Calendar and
Contact Integration

Step 1
Step 2
Step 3
Step 4

Step 5
Step 6
Step 7

Step 8

Step 9

Do the following procedure.

To Configure Cisco Unity Connection for the Exchange 2003 Calendar and Contact Integration

In Cisco Unity Connection Administration, expand System Settings, then select External Services.
On the Search External Services page, select Add New.

On the New External Service page, in the Type list, select Exchange 2003 External Service Template.
Check the Enabled check box to enable the external service.

When this check box is not checked, the integration with Exchange 2003 is disabled.

In the Display Name field, enter a descriptive name.

In the Server field, enter the IP address or host name for the Exchange 2003 server.

In the Authentication Mode field, select the applicable setting to match the authentication mode that is
used by the Exchange server.

In the Security Transport field, select the applicable setting:
¢ None—Unity Connection does not use a secure Unity Connection with the Exchange 2003 server.
¢ SSL—Unity Connection uses an SSL Unity Connection with the Exchange 2003 server.

If you selected “SSL” and you want Unity Connection to validate the Exchange 2003 server certificate,
check the Validate Server Certificate check box.
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Step 10

Step 11

Step 12
Step 13
Step 14

Self-signed certificates cannot be validated. If you selected SSL and you are using self-signed
certificates, do not check the Validate Server Certificate check box, or Unity Connection will not be able
to access Exchange.

A

Caution  The CN value on the server certificate subject line or the subjectAltName:dnsname field of
the server certificate must match the setting of Server field. Otherwise, validation of the server
certificate will fail.

The root certificate or all certificates in a root certificate chain of the Certification Authority
(CA) that signed the server certificate must be installed as Unity Connection-trust certificates
in Cisco Unified Operating System Administration. Otherwise, validation of the server
certificate will fail.

In the Alias field, enter the Windows domain and alias for the privileged service account that Unity
Connection uses to sign in to the Exchange 2003 server. (For example, enter “doman\alias”).

This setting must match the user ID for the privileged service account that is configured in Exchange
2003.

In the Password field, enter the password for the privileged service account that Unity Connection uses
to sign in to the Exchange 2003 server.

This setting must match the user password for the privileged service account that is configured in
Exchange 2003.

Under Service Capabilities, check the User Access to Calendar and Personal Contacts check box.
Select Save.

To check the integration with Exchange 2003, select Test. The Task Execution Results window appears
with the test results.

If any part of the test fails, verify the configuration for Exchange 2003 and Cisco Unity Connection.

Configuring Users for the Exchange 2003 Calendar and Contact Integration in
Cisco Unity Connection

~

Note

Step 1
Step 2

Do the following procedure.

Exchange 2003 must have a mailbox and Active Directory must have a user for each Unity Connection
user that you are configuring.

To Configure Users for the Exchange 2003 Calendar and Contact Integration in Cisco Unity Connection

In Cisco Unity Connection Administration, expand Users, then select Users.
On the Search Users page, select the alias of a user.

S

Note  If the user alias does not appear in the search results table, set the applicable parameters in the
search fields at the top of the page, and select Search.
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Step 3
Step 4
Step 5

Step 6
Step 7

Step 8

Step 9

Step 10
Step 11

Step 12
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On the Edit User Basics page, on the Edit menu, select External Service Accounts.
On the External Service Accounts page, select Add New.

On the New External Service Accounts page, in the External Service field, select the display name
that you entered in the “To Configure Cisco Unity Connection for the Exchange 2003 Calendar and
Contact Integration” procedure on page 36-13.

In the Email Address field, enter the primary SMTP address in Active Directory for the user.
In the Sign-In Type field, select the applicable option:

¢ Use Unity Connection Alias—This option is useful when the User ID setting in Active Directory
is the same as the Unity Connection user alias. Unity Connection signs in the user with the Unity
Connection user alias.

e Use User ID Provided Below—Enter the User ID setting from Active Directory (useful when the
User ID setting is different from the Unity Connection user alias). Unity Connection signs in the
user with the setting in this field.

(Only when the Use User ID Provided Below option is selected in Step 7) In the User ID field, enter the
User ID setting from Active Directory.

Under Service Capabilities, check the User Access to Calendar and Personal Contacts check box.

~

Note A user can have only one external service that has the User Access to Calendar and Personal
Contacts check box or the User Access to Calendar check box checked.

Select Save.

To check the calendar configuration for the user, select Test. The Task Execution Results window
appears with the test results.

If any part of the test fails, verify the configuration for Exchange 2003, Cisco Unity Connection, and the
user.

Repeat Step 2 through Step 11 for all remaining users.

Testing the Exchange 2003 Calendar Integration in Cisco Unity Connection Do
the following procedure.

Step 1
Step 2
Step 3
Step 4

Step 5
Step 6

To Test the Exchange 2003 Calendar Integration in Cisco Unity Connection

Sign in to Outlook.
On the Go menu, select Calendar.
On the File menu, select New > Meeting Request.

Enter values in the required fields to schedule a new meeting for the current time, and invite a user who
has an account on Cisco Unity Connection.

Select Send.

Sign in to the Unity Connection mailbox of the user that you invited to the Outlook meeting in Step 4.
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Step7  If the user account is configured for speech access, say Play Meetings.

If the user account is not configured for speech access, press 6, and then follow the prompts to list
meetings.

Unity Connection reads the information about the Exchange 2003 meeting.

Creating a Calendar and Contact Integration with Cisco Unified
MeetingPlace in Cisco Unity Connection

If you have Cisco Unified MeetingPlace installed, you can integrate Cisco Unity Connection with Cisco
Unified MeetingPlace so that users can review upcoming meetings and join active meetings by phone.

For information on configuring calendar and contact integrations in Cisco Unity Connection, see the
“Configuring Cisco Unity Connection 10.x and Later and Microsoft Exchange for Unified Messaging”
chapter and/or the “Configuring Cisco Unity Connection 10.x and Later and Cisco Unified MeetingPlace
for Unified Messaging” chapter of the Unified Messaging Guide for Cisco Unity Connection, available
at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/10x/unified_messaging/guide/10xcucu
mgx.html.

Task List for Creating a Calendar Integration with Cisco Unified MeetingPlace
in Cisco Unity Connection

1. Review the system requirements to confirm that all requirements for Cisco Unified MeetingPlace
and the Cisco Unity Connection server have been met. See the “Requirements for the Cisco Unified
MeetingPlace Calendar Integration in Cisco Unity Connection” section on page 36-16.

2. Configure Cisco Unified MeetingPlace. See the “Configuring Cisco Unified MeetingPlace for the
Calendar Integration in Cisco Unity Connection” section on page 36-17.

3. Configure Unity Connection. See the “Configuring Cisco Unity Connection for the Cisco Unified
MeetingPlace Calendar Integration” section on page 36-18.

4. Configure the Unity Connection users. See the “Configuring Users for the Cisco Unified
MeetingPlace Calendar Integration in Cisco Unity Connection” section on page 36-19.

5. Test the calendar integration. See the “Testing the Calendar Integration for the Cisco Unified
MeetingPlace Calendar Integration in Cisco Unity Connection” section on page 36-20.

6. To teach users how to list, join, and schedule meetings, see the “Cisco Unity Connection Phone
Menus and Voice Commands” chapter of the User Guide for the Cisco Unity Connection Phone
Interface (Release 10.x) at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/10x/user/guide/phone/b_10xcucugp
hone.html.

Requirements for the Cisco Unified MeetingPlace Calendar Integration in
Cisco Unity Connection

The calendar integration with Cisco Unified MeetingPlace has the following requirements:
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e Cisco Unified MeetingPlace as described in the “Requirements for Accessing Calendar Information
for Meetings” section of System Requirements for Cisco Unity Connection Release 10.x at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/10x/requirements/10xcucsysreqs.ht
ml.

e Cisco Unity Connection installed as described in the Installation Guide for Cisco Unity Connection
Release 10.x at

http://www.cisco.com/en/US/docs/voice_ip_comm/connection/10x/installation/guide/10xcucigx.ht
ml.

Configuring Cisco Unified MeetingPlace for the Calendar Integration in
Cisco Unity Connection

Step 1
Step 2
Step 3
Step 4

Step 5
Step 6

Do the following procedure.

To Configure Cisco Unified MeetingPlace for the Calendar Integration in Cisco Unity Connection

Sign in to the Cisco Unified MeetingPlace Application Server as an administrator.
Select User Configuration > User Profiles.

Select Add New.

Enter the following values in the required fields to create a privileged service account:

First Name Leave this field blank.

Last Name Enter Cisco Unity Connection.

User ID Enter cucsve or another user ID that you want.
User Password Enter the applicable password.

Profile Number Enter the applicable profile number.

Profile Password | Enter the applicable profile password.

Type of User Select System Administrator.

~

Note  The values that you enter for the User ID, User Password, Profile Number, and Profile Password
fields will be used in the “Configuring Cisco Unity Connection for the Cisco Unified
MeetingPlace Calendar Integration” section on page 36-18.

Select Save.

Sign out of Cisco Unified MeetingPlace.

A

Caution  If you do not sign out of Cisco Unified MeetingPlace, the test will fail in the “To Test the
Cisco Unified MeetingPlace Configuration for the Calendar Integration in Cisco Unity
Connection” procedure on page 36-18.
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To Test the Cisco Unified MeetingPlace Configuration for the Calendar Integration in Cisco Unity Connection

Step 1 In the Address field of a web browser, if SSL is not enabled, enter the following URL (where <server>
is the IP address or host name of the Cisco Unified MeetingPlace server):

http://<server>/webservices/services/meetingservice?wsdl
If SSL is enabled, enter the following URL.:
https://<server>/webservices/services/meetingservice?wsdl
Step2  Press Enter.

Step3  When prompted to sign in, enter the user ID and password for the privileged service account that you
created in the “To Configure Cisco Unified MeetingPlace for the Calendar Integration in Cisco Unity
Connection” procedure on page 36-17.

The Cisco Unified MeetingPlace WSDL download page appears with the title “XFire Services.”

Configuring Cisco Unity Connection for the Cisco Unified MeetingPlace
Calendar Integration

Do the following procedure.

To Configure Cisco Unity Connection for the Cisco Unified MeetingPlace Calendar Integration

Step 1 In Cisco Unity Connection Administration, expand System Settings, then select External Services.
Step2  On the Search External Services page, select Add New.

Step3  On the New External Service page, in the Type list, select MeetingPlace 7.0/8.0 External Service
Template.

Stepd  Check the Enabled check box to enable the external service.

When this check box is not checked, the integration with Cisco Unified MeetingPlace is disabled.
Step5  In the Display Name field, enter a descriptive name.
Step6  In the Server field, enter the IP address or host name for the Cisco Unified MeetingPlace server.

Step7 In the Transfer Extension Dial String field, enter the digits that Unity Connection must dial to transfer
users on the phone to the opening greeting of Cisco Unified MeetingPlace server.

Step8  In the Security Transport field, select the applicable setting:

¢ None—Unity Connection does not use a secure Unity Connection with the Cisco Unified
MeetingPlace server.

e SSL—Unity Connection uses an SSL Unity Connection with the Cisco Unified MeetingPlace
server.

Step9  If you selected “SSL” and you want Unity Connection to validate the Cisco Unified MeetingPlace server
certificate, check the Validate Server Certificate check box.

Self-signed certificates cannot be validated. If you selected SSL and you are using self-signed
certificates, do not check the Validate Server Certificate check box, or Unity Connection will not be
able to access Cisco Unified MeetingPlace.
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Step 10

Step 11

Step 12

Step 13
Step 14
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A

Caution  The CN value on the server certificate subject line or the subjectAltName:dnsname field of
the server certificate must match the setting of Server field. Otherwise, validation of the server
certificate will fail.

The root certificate or all certificates in a root certificate chain of the Certification Authority
(CA) that signed the server certificate must be installed as Unity Connection-trust certificates
in Cisco Unified Operating System Administration. Otherwise, validation of the server
certificate will fail.

In the Alias field, enter the alias for the privileged service account that Unity Connection uses to sign in
to the Cisco Unified MeetingPlace server.

This setting must match the User ID setting for the privileged service account that you configured in the
“Configuring Cisco Unified MeetingPlace for the Calendar Integration in Cisco Unity Connection”
section on page 36-17.

In the Password field, enter the password for the privileged service account that Unity Connection uses
to sign in to the Cisco Unified MeetingPlace server.

This setting must match the User Password setting for the privileged service account that you configured
in the “Configuring Cisco Unified MeetingPlace for the Calendar Integration in Cisco Unity
Connection” section on page 36-17.

Under Service Capabilities, check the applicable check boxes:

e User Access to Calendar—Check this check box so that users can hear of their upcoming meetings
by phone.

¢ MeetingPlace Scheduling and Joining—Check this check box so that users can schedule and join
meetings.

Select Save.

To check the integration with Cisco Unified MeetingPlace, select Test. The Task Execution Results
window appears with the test results.

If any part of the test fails, verify the configuration for Cisco Unified MeetingPlace and Cisco Unity
Connection.

Configuring Users for the Cisco Unified MeetingPlace Calendar Integration in
Cisco Unity Connection

A

Do the following procedure.

Caution

Step 1
Step 2

Cisco Unified MeetingPlace must have an end user for each Unity Connection user that you are
configuring.

To Configure Users for the Cisco Unified MeetingPlace Calendar Integration in Cisco Unity Connection

In Cisco Unity Connection Administration, expand Users, then select Users.

On the Search Users page, select the alias of a user.
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Step 3
Step 4

Step 5

Step 6

Step 7

Step 8

Step 9
Step 10

Step 11

On the Edit User Basics page, on the Edit menu, select External Service Accounts.

On the External Service Accounts page, select Add New. The New External Service Account page
appears.

In the External Service field, select the display name that you entered in the “Configuring Cisco Unity
Connection for the Cisco Unified MeetingPlace Calendar Integration” section on page 36-18.

In the Sign-In Type field, select the applicable option:

¢ Use Unity Connection Alias—This option is useful when the Cisco Unified MeetingPlace profile
alias is the same as the Unity Connection user alias. Unity Connection signs in the user with the
Unity Connection user alias. Cisco Unified MeetingPlace provides information on public and private
meetings to the user.

¢ Use Server Guest Account—Unity Connection signs in the user as a guest, without using the Unity
Connection user alias or the User ID setting. Cisco Unified MeetingPlace provides information only
on public meetings to the user.

e Use User ID Provided Below—Enter the profile alias from Cisco Unified MeetingPlace (useful
when the Cisco Unified MeetingPlace profile alias is different from the Unity Connection user
alias). Unity Connection signs in the user with the setting in this field. Cisco Unified MeetingPlace
provides information on public and private meetings to the user.

(Only when the Use User ID Provided Below option is selected in Step 6) In the User ID field, enter the
User ID setting from Cisco Unified MeetingPlace.

Under Service Capabilities, check the applicable check boxes:

e MeetingPlace Scheduling and Joining—Check this check box so that the user can schedule and
join meetings.

¢ Primary Meeting Service—If the MeetingPlace Scheduling and Joining check box is checked for
two or more external services, check this check box so that Cisco Unified MeetingPlace meetings
will be set up through this Cisco Unified MeetingPlace server. Uncheck this check box so that Cisco
Unified MeetingPlace meetings will be set up through another server.

Select Save.

To check the calendar configuration for the user, select Test. The Task Execution Results window
appears with the test results.

If any part of the test fails, verify the configuration for Cisco Unified MeetingPlace, Cisco Unity
Connection, and the user.

Repeat Step 2 through Step 10 for all remaining users.

Testing the Calendar Integration for the Cisco Unified MeetingPlace Calendar
Integration in Cisco Unity Connection

Step 1
Step 2

Do the following procedure.

To Test the Configuration for the Cisco Unified MeetingPlace Calendar Integration in Cisco Unity Connection

Sign in to Cisco Unified MeetingPlace as an end user.

Select Schedule.
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Step 3

Step 4

Step 5

Step 6
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Enter values in the required fields to schedule a new meeting for the current time, and invite a user who
has an account on Cisco Unity Connection.

Sign in to the Unity Connection mailbox of the user that you invited to the Cisco Unified MeetingPlace
meeting in Step 3.

If the user account is configured for speech access, say Play Meetings.

If the user account is not configured for speech access, press 6, and then follow the prompts to list
meetings.

When you hear the system announce the Cisco Unified MeetingPlace meeting that you just scheduled,
either say Join, or press the applicable keys on the phone keypad to join the meeting.

Creating a Calendar Integration with Cisco Unified
MeetingPlace Express in Cisco Unity Connection

If you have Cisco Unified MeetingPlace Express installed, you can integrate Cisco Unity Connection
with Cisco Unified MeetingPlace Express so that users can review upcoming meetings and join active
meetings by phone or while using the Cisco Personal Communications Assistant (PCA).

Use the following task list to create a calendar integration.

For information on configuring calendar and contact integrations in Cisco Unity Connection, see the
“Configuring Cisco Unity Connection 10.x and Later and Microsoft Exchange for Unified Messaging”
chapter and/or the “Configuring Cisco Unity Connection 10.x and Later and Cisco Unified MeetingPlace
for Unified Messaging” chapter of the Unified Messaging Guide for Cisco Unity Connection, available
at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/10x/unified_messaging/guide/10xcucu
mgx.html.

Task List for Creating a Calendar Integration with Cisco Unified MeetingPlace
Express in Cisco Unity Connection

1. Review the system requirements to confirm that all requirements for Cisco Unified MeetingPlace
Express and the Cisco Unity Connection server have been met. See the “Requirements for the Cisco
Unified MeetingPlace Express Calendar Integration in Cisco Unity Connection” section on
page 36-22.

2. Configure Cisco Unified MeetingPlace Express. See the “Configuring Cisco Unified MeetingPlace
Express for the Calendar Integration in Cisco Unity Connection” section on page 36-22.

3. Configure Unity Connection. See the “Configuring Cisco Unity Connection for the Cisco Unified
MeetingPlace Express Calendar Integration” section on page 36-23.

4. Configure the Unity Connection users. See the “Configuring Users for the Cisco Unified
MeetingPlace Express Calendar Integration in Cisco Unity Connection” section on page 36-25.

5. Test the calendar integration. See the “Testing the Cisco Unified MeetingPlace Express Calendar
Integration in Cisco Unity Connection” section on page 36-26.
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6. To teach users how to list, join, and schedule meetings, see the “Cisco Unity Connection Phone
Menus and Voice Commands” chapter of the User Guide for the Cisco Unity Connection Phone
Interface (Release 10.x) at

http://www.cisco.com/en/US/docs/voice_ip_comm/connection/10x/user/guide/phone/b_10xcucugp
hone.html.

Requirements for the Cisco Unified MeetingPlace Express Calendar Integration
in Cisco Unity Connection

The calendar integration with Cisco Unified MeetingPlace Express has the following requirements:

e Cisco Unified MeetingPlace Express as described in the “Requirements for Accessing Calendar
Information for Meetings” section of System Requirements for Cisco Unity Connection Release 10.x
at

http://www.cisco.com/en/US/docs/voice_ip_comm/connection/10x/requirements/10xcucsysreqs.ht
ml.

¢ Cisco Unity Connection installed as described in the Installation Guide for Cisco Unity Connection
Release 10.x at

http://www.cisco.com/en/US/docs/voice_ip_comm/connection/10x/installation/guide/10xcucigx.ht
ml.

Configuring Cisco Unified MeetingPlace Express for the Calendar Integration in
Cisco Unity Connection

Step 1
Step 2
Step 3
Step 4

Do the following procedure.

To Configure Cisco Unified MeetingPlace Express for the Calendar Integration in Cisco Unity Connection

Sign in to Cisco Unified MeetingPlace Express and select Administration.
Select User Configuration > User Profile Management.

Select Add New.

Enter the following values in the required fields to create an API user:

First Name Leave this field blank.

Last Name Enter Cisco Unity Connection.

User ID Enter cucsve or another user ID that you want.
User Password Enter the applicable password.

Profile Number Enter the applicable profile number.

Type of User Select API User.

~

m The values that you enter for the User ID, User Password, and Profile Number fields will be used
in the “Configuring Cisco Unity Connection for the Cisco Unified MeetingPlace Express
Calendar Integration” section on page 36-23.
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Step5  Select Save.
Step6  Sign out of Cisco Unified MeetingPlace Express.

A

Caution  If you do not sign out of Cisco Unified MeetingPlace Express, the test will fail in the “To Test
the Cisco Unified MeetingPlace Express Configuration for the Calendar Integration in
Cisco Unity Connection” procedure on page 36-23.

To Test the Cisco Unified MeetingPlace Express Configuration for the Calendar Integration in Cisco Unity
Connection

Step 1 In the Address field of a web browser, if SSL is not enabled, enter the following URL (where <server>
is the IP address or host name of the Cisco Unified MeetingPlace Express server):

http://<server>.com/webservices/services/meetingservice?wsdl
If SSL is enabled, enter the following URL.:
https://<server>.com/webservices/services/meetingservice?wsdl
Step2  Press Enter.

Step3  When prompted to sign in, enter the user ID and password for the API user that you entered in the “To
Configure Cisco Unified MeetingPlace Express for the Calendar Integration in Cisco Unity Connection”
procedure on page 36-22.

i

The Cisco Unified MeetingPlace Express WSDL download page appears with the title “XFire Services.’

Configuring Cisco Unity Connection for the Cisco Unified MeetingPlace
Express Calendar Integration

Do the following procedure.

To Configure Cisco Unity Connection for the Cisco Unified MeetingPlace Express Calendar Integration

Step1  In Cisco Unity Connection Administration, expand System Settings, then select External Services.
Step2  On the Search External Services page, select Add New.

Step3  Onthe New External Service page, in the Type list, select MeetingPlace Express 2.0 External Service
Template.

Stepd  Check the Enabled check box.

When this check box is not checked, the calendar integration with Cisco Unified MeetingPlace Express
is disabled.

Step5 In the Display Name field, enter a descriptive name. For example, enter “Cisco Unified MeetingPlace
Express calendar.”

Step6  Inthe Server field, enter the IP address or host name for the Cisco Unified MeetingPlace Express server.
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Step 7

Step 8

Step 9

Step 10

Step 11

Step 12

Step 13
Step 14

In the Transfer Extension Dial String field, enter the digits that Unity Connection must dial to transfer
users on the phone to the opening greeting of Cisco Unified MeetingPlace Express server.

In the Security Transport field, select the applicable setting:

¢ None—Unity Connection does not use a secure Unity Connection with the Cisco Unified
MeetingPlace Express server.

e SSL—Unity Connection uses an SSL Unity Connection with the Cisco Unified MeetingPlace
Express server.

If you selected “SSL” and you want Unity Connection to validate the Cisco Unified MeetingPlace
Express server certificate, check the Validate Server Certificate check box.

Self-signed certificates cannot be validated. If you selected SSL and you are using self-signed
certificates, do not check the Validate Server Certificate check box, or Unity Connection will not be able
to access Cisco Unified MeetingPlace Express.

A

Caution  The CN value on the server certificate subject line or the subjectAltName:dnsname field of
the server certificate must match the setting of Server field. Otherwise, validation of the server
certificate will fail.

The root certificate or all certificates in a root certificate chain of the CA that signed the server
certificate must be installed as Unity Connection-trust certificates in Cisco Unified Operating
System Administration. Otherwise, validation of the server certificate will fail.

In the Alias field, enter the alias for the API user that Unity Connection uses to sign in to the Cisco
Unified MeetingPlace Express server.

This setting must match the User ID setting for the API user that you configured in the “Configuring
Cisco Unified MeetingPlace Express for the Calendar Integration in Cisco Unity Connection” section on
page 36-22.

In the Password field, enter the password for the API user that Unity Connection uses to sign in to the
Cisco Unified MeetingPlace Express server.

This setting must match the User Password setting for the API user that you configured in the
“Configuring Cisco Unified MeetingPlace Express for the Calendar Integration in Cisco Unity
Connection” section on page 36-22.

Under Service Capabilities, check the applicable check boxes:

e User Access to Calendar—Check this check box so that users can hear their upcoming meetings
on the phone.

e MeetingPlace Scheduling and Joining—Check this check box so that users can schedule and join
meetings.

Select Save.

To check the integration with Cisco Unified MeetingPlace Express, select Test. The Task Execution
Results window appears with the test results.

If any part of the test fails, verify the configuration for Cisco Unified MeetingPlace Express and
Cisco Unity Connection.
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Configuring Users for the Cisco Unified MeetingPlace Express Calendar
Integration in Cisco Unity Connection

S

Note

Step 1
Step 2
Step 3
Step 4

Step 5

Step 6

Step 7

Step 8

Step 9

Do the following procedure.

Cisco Unified MeetingPlace Express must have an end user for each Unity Connection user that you are
configuring.

To Configure Users for the Cisco Unified MeetingPlace Express Calendar Integration in Cisco Unity Connection

In Cisco Unity Connection Administration, expand Users, then select Users.
On the Search Users page, select the alias of a user.
On the Edit User Basics page, on the Edit menu, select External Service Accounts.

On the External Service Accounts page, select Add New. The New External Service Accounts page
appears.

In the External Service field, select the display name that you entered in the “Configuring Cisco Unity
Connection for the Cisco Unified MeetingPlace Express Calendar Integration” section on page 36-23.

In the Sign-In Type field, select the applicable option:

e Use Unity Connection Alias—This option is useful when the Cisco Unified MeetingPlace Express
profile alias is the same as the Unity Connection user alias. Unity Connection signs in the user with
the Unity Connection user alias. Cisco Unified MeetingPlace Express provides information on
public and private meetings to the user.

¢ Use Server Guest Account—Unity Connection signs in the user as a guest, without using the Unity
Connection user alias or the User ID setting. Cisco Unified MeetingPlace Express provides
information only on public meetings to the user.

e Use User ID Provided Below—Enter the profile alias from Cisco Unified MeetingPlace Express
(useful when the Cisco Unified MeetingPlace Express profile alias is different from the Unity
Connection user alias). Unity Connection signs in the user with the setting in this field. Cisco
Unified MeetingPlace Express provides information on public and private meetings to the user.

(Only when the Use User ID Provided Below option is selected in Step 6) In the User ID field, enter the
User ID setting from Cisco Unified MeetingPlace Express.

(Only if enabled) In the User Profile Number field, enter the User ID setting from Cisco Unified
MeetingPlace Express. Unity Connection signs in the user with the setting in this field.

Under Service Capabilities, check the applicable check boxes:

e User Access to Calendar—Check this check box so that users can hear their upcoming meetings
by phone.

~

Note A user can have only one external service that has the User Access to Calendar and Personal
Contacts check box or the User Access to Calendar check box checked.

¢ MeetingPlace Scheduling and Joining—Check this check box so that the user can schedule and
join meetings.
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Step 10
Step 11

Step 12

¢ Primary Meeting Service—If the MeetingPlace Scheduling and Joining check box is checked for
two or more external services, check this check box so that Cisco Unified MeetingPlace Express
meetings will be set up through this Cisco Unified MeetingPlace Express server. Uncheck this check
box so that Cisco Unified MeetingPlace Express meetings will be set up through another server.

Select Save.

To check the calendar configuration for the user, select Test. The Task Execution Results window
appears with the test results.

If any part of the test fails, verify the configuration for Cisco Unified MeetingPlace Express, Cisco Unity
Connection, and the user.

Repeat Step 2 through Step 11 for all remaining users.

Testing the Cisco Unified MeetingPlace Express Calendar Integration in
Cisco Unity Connection

Step 1
Step 2
Step 3

Step 4

Step 5

Step 6

Do the following procedure.

To Test the Cisco Unified MeetingPlace Express Calendar Integration in Cisco Unity Connection

Sign in to Cisco Unified MeetingPlace Express as an end user.
Select Schedule.

Enter values in the required fields to schedule a new meeting for the current time, and invite a user who
has an account on Cisco Unity Connection.

Sign in to the Unity Connection mailbox of the user that you invited to the Cisco Unified MeetingPlace
Express meeting in Step 3.

If the user account is configured for speech access, say Play Meetings.

If the user account is not configured for speech access, press 6, and then follow the prompts to list
meetings.

When you hear the system announce the Cisco Unified MeetingPlace Express meeting that you just
scheduled, either say Join, or press the applicable keys on the phone keypad to join the meeting.
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